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EXPERIMENT NO:1 
AIM:  Introduction to circuit creation and simulation software TINAPRO  

APPARATUS: PC installed with TINAPRO. 

THEORY: The study of TINAPRO mainly consists of:  
 
Introduction to TINAPRO Capture: 
Generation of Schematic 
Generation of net list 
 
SCHEMATIC: 
A schematic is merely a collection of electronic symbols connected together with virtual “wires.” 
The main reason you need a schematic when fabricating a printed circuit board is to provide 
input (a net list) to your layout and routing tool. 
  
 
NETLIST: 
A net list is a file, usually ASCII text, which defines the connections between the components in 
your design. 
  
  
CREATING PROJECT:   
 
To create a new project, use Capture’s Project Wizard. The Project Wizard provides you with the 
framework for creating any kind of project. 
 
1 Launch Capture. 
2 From the File menu, choose New > Project. 
3 In the New Project dialog box, specify the project name 
4 To specify the project type, select Analog or Mixed A/D. 
5 Specify the location where you want the project files to be created and click OK. 
6 In the Create PSpice Project dialog box, select the 
Create a blank project option button. 
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Adding parts: 
 
To add parts to your design: 
1 From the Place menu in Capture, select Part. 
2 In the Place Part dialog box, first select the library from which the part is to be added and then 
instantiate the part on the schematic page. While working with the  Capture, add parts from 
“Name of Libraray”.OLB. To add libraries to the project, select the Add Library button. 
3 Browse to <install_dir>/tools/capture/library/pspice/eval.olb. 
 
Connecting parts: 
 
After placing the required parts on the schematic page, you need to connect the parts. 
From the Place menu, choose Wire. 
 
Net List: 
 
Save the schematic and close the schematic page. 
Open tools and create net list. 
Select Layout tab. 
Be sure to put the *.MNL file in a unique folder.  
Latter many more design  files will be generated and it will be much easier to sort them out if the 
design is by itself. 
Click on OK 
The net list that Layout needs has been created.  The file has the name of the project.MNL 
 
CONCLUSION: Thus we have studied the TINAPRO circuit capturing, Generation of 
Schematic and net list..  
 
QUIZ QUESTIONS & ANSWERS 

Q. 1 What is TINA Design Suite? 

Ans. TINA Design Suite is a powerful yet affordable circuit simulation and PCB design software 
package. 

Q.2 Why TINA Design Suite  is used? 

Ans. It is used for analyzing, designing, and real time testing of analog, digital, VHDL, MCU, 
and mixed electronic circuits and their PCB layouts. 

Q.3 What is unique feature of TINA? 
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Ans. A unique feature of TINA is that you can bring your circuit to life with the optional USB 
controlled. 

Q.4 How it is used to compute computational power? 

Ans. To meet this requirement TINA v9 has the ability to utilize the increasingly popular 
scalable multi-thread CPUs. 

Q.5 What is the use of schematic editor in Tina Pro? 

Ans. It enhances your schematics by adding text and graphics elements such lines, arcs arrows, 
frames around the schematics and title blocks.  

Q.6 How many manufacturer models it contain? 

Ans. More than 20,000. 

Q.7 Name all the Virtual Instruments used in it. 

Ans. Virtual Instruments: Oscilloscope, Function Generator, Multimeter, Signal Analyzer/Bode 
Plotter, Network Analyzer, Spectrum Analyzer, Logic Analyzer, Digital Signal Generator, XY 
Recorder. 

Q.8 What is Real-time Storage Oscilloscope? 

Ans.It observes the actual time response of your circuit. 

Q.9 What is Real-time Signal Analyzer? 

Ans. It measure the frequency response of your circuit in real-time. 

 

Q.10 What’s role Tina play in Integrated PCB design? 

Ans. The new fully integrated layout module of TINA has all the features you need for advanced 
PCB design, including multilayer PCB's with split power plane layers, powerful autoplacement 
& autorouting, rip-up and reroute, manual and "follow-me" trace placement, DRC, forward and 
back annotation, pin and gate swapping, keep-in and keep-out areas, copper pour, thermal relief, 
fanout, 3D view of your PCB design from any angle, Gerber file output and much more. 
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EXPERIMENT NO:2 
AIM:  Introduction to Layout Tool, and creating Layout board using TINAPRO 

APPARATUS: PC installed with TINAPRO 

THEORY:  
 
TINAPRO Layout 
TINAPRO tool used for PCB routing and floor-planning 
 
LAYOUT: 
 
Layout is a circuit board layout tool that accepts a layout-compatible circuit netlist (ex. from 
Capture CIS) and generates an output layout files that suitable for PCB fabrication 
  
CREATING LAYOUT BOARD: 
  
Having created the layout netlist, the next step is to create a new board in Layout. 
Launch Layout 
Create the Layout board file 
When you create a new board file in OrCAD Layout, you merge the electrical information from 
the layout netlist (.MNL) and physical information from a template file (.TPL) or a technology 
file (.TCH) to create a new board design (.MAX). Therefore, to be able to create a board file for 
a new design in Layout, you need to provide a template file and a netlist. A template (.TPL) file 
describes the characteristics of a physical board. A template can include information, such as the 
board outline, the design origin, the layer definitions, grid settings, spacing rules, and default 
track widths. 

1. From the File menu in OrCAD Layout, choose New. The AutoECO dialog box appears. 
2. In the Input Layout TCH or TPL or MAX file text box, specify the name and the location 

of the technology file to be used for your board 
3. In the Input MNL netlist file text box, specify the location of the FULLADD.MNL 

created in the Creating Layout netlist section. 
4. From the drop-down list in the Options section, select AutoECO. 

 
 

CONCLUSION: Thus we have studied the TINAPRO circuit TINAPRO Layout and tool used 
for PCB routing and floor-planning 
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QUIZ QUESTIONS & ANSWERS 

Q.1 What is layout? 
Ans. Layout is a circuit board layout tool that accepts a layout-compatible circuit netlist (ex. 
from Capture CIS) and generates an output layout files that suitable for PCB fabrication. 
 
Q.2 What do you mean by SCHEMATIC? 
Ans. A schematic is merely a collection of electronic symbols connected together with virtual 
“wires.” The main reason you need a schematic when fabricating a printed circuit board is to 
provide input (a netlist) to your layout and routing tool. 
 
Q.3 What is netlist? 
Ans. A netlist is a file, usually ASCII text, which defines the connections between the 
components in your design. 
 
Q.4 What's new in version 9.2 of Tina? 
Ans. Schematic Symbol Editor (useable with the Macro Wizard) is included, so you can create 
your own symbols for imported SPICE macro models. 
 

Q.5 What's new in version 9.3 of Tina? 
Ans.It does not require active or non-linear components for analysis (so you can now run a 
circuit using just passives). 
 

Q.6 What is user-friendly interface? 
Ans. The user-friendly interface makes it easy to find the necessary tools for designing a circuit. 
There are several switches, meters, sources, semiconductors and spice macros to choose from. 
When evaluating a circuit in function mode, a multimeter, oscilloscope, a signal analyzer and 
others can also be used. 
 
Q.7  Whai is the use of schematic editor in Tina Pro? 
Ans.It enhance your schematics by adding text and graphics elements such lines, arcs arrows, 
frames around the schematics and title blocks.  
 
Q.8 How many manufacturer models it contain? 
Ans. More than 20,000. 
 
Q.9 What is unique feature of TINA? 
Ans. A unique feature of TINA is that you can bring your circuit to life with the optional USB 
controlled. 
 
Q.10 How many number or devices and nodes can be included in it? 
Ans. The number or devices and nodes that can be included in a circuit is not limited. 
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EXPERIMENT NO:3 
 

AIM:  Design a half wave rectifier using TINAPRO and observe its output on a virtual 
oscilloscope. 
APPARATUS: PC installed with TINAPRO 

CIRCUIT DIAGRAM:  
 
 
 
 
 
 
 
 
 

 
 

 
 

 
 
 
 
 
 
 
PROGRAM:  
 
*HALF WAVE rectifier  
Vin 2 0 sin(0 220 50 )  
RL 5 0 500  
RS 2 1 10  
L1 1 0 2000  
L2 3 0 20  
K1 L1 L2 0.99999  
D1 3 5 mod1  
.model mod1 D (IS=1e-14, n=1)  
.tran 0.2m 200m  
.plot tran v(3), v(5)  
.probe 
.end 

51
D1

mod1

RL

500

Rs

10

Vin

FREQ = 50Hz
VAMPL = 220V
VOFF = 0

2

L1

2000uH

3

L2

20uH

HALF WAVE RECTIFIER
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RESULT:  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
CONCLUSION: Thus we have studied the half wave rectifier using TINAPRO window and 
observed its output on the virtual CRO. 
 

QUIZ QUESTIONS & ANSWERS 

Q.1What is rectifier? 

Ans. A rectifier is an electrical device that converts alternating current (AC), which periodically 
reverses direction, to direct current (DC), which flows in only one direction. The process is 
known as rectification.  

Q.2 What is half wave rectifier? 

Ans. In half wave rectification of a single-phase supply, either the positive or negative half of the 
AC wave is passed, while the other half is blocked. 

Q.3 Relate input frequency and the output frequencies of a half wave rectifier and  a full wave 
rectifier? 

 
  HALF WAVE RECTIFIER  
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Ans.In half-wave rectification, we get pulsating output for half cycle only.Therefore output 
ripple frequency is same as the input frequency. But in full wave rectification we get output for 
both half cycle. Hence the output at ripple frequency is full-wave rectification is double the input 
frequency. 

Q.4 What is the application of rectifier? 

Ans.The primary application of rectifiers is to derive DC power from an AC supply. Virtually all 
electronic devices require DC, so rectifiers are used inside the power supplies of virtually all 
electronic equipment. 

Q.5 What do you mean by forward biased? 

Ans. When +ve terminal of battery is connected to P side & -ve terminal to N side of diode. 

Q.6 What do you mean by reverse biased? 

Ans. When +ve terminal of battery is connected to N side & -ve terminal to P side of diode. 

Q.7  Define Knee voltage. 

Ans. The forward voltage at which current through the junction starts increasing rapidly.  

Q.8  Define breakdown voltage. 

 Ans.  Reverse voltage at which PN junction breaks down with sudden rise in reverse current. 

Q.9 Define max. Forward current. 

Ans.  It is highest instantaneous forward current that a PN junction can conduct without damage 
to Junction. 

Q.10 What is the difference between active and passive components?  

Ans. Passive elements don't require power from the supply to produce its effect on a signal. They 
derive the power of the input signal to perform its action. for example, a resistor doesn't require a 
separate supply to provide its action of resistance in a circuit.  Where as in active elements there 
should be a power source for its working. They require a supply for there working.   
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EXPERIMENT NO:4 
AIM:  Design a full wave centre tapped rectifier using TINAPRO & its output on a virtual 
oscilloscope. 

APPARATUS: PC installed with TINAPRO 

CIRCUIT DIAGRAM:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
PROGRAM:  
 
*FULL WAVE rectifier   
Vin 2 0 sin(0 230V 50HZ)  
RL 5 4 1000  
RS 2 1 10  
L1 1 0 2000  
L2 3 4 10 
L3 4 0 10 
K1 L1 L2 L3 0.99  
D1 0 5 D1N4009  
D2 3 5 D1N4009 
.model D1N4009 D(Is=544.7E-21 N=1 Rs=.1 Ikf=0 Xti=3 Eg=1.11 Cjo=4p M=.3333 
+               Vj=.75 Fc=.5 Isr=30.77n Nr=2 Bv=25 Ibv=100u Tt=2.885n)  
.tran 0.2ms 200ms 
.probe 
.end 

L1

2000uH

L3

10uH

2

Vin

FREQ = 50Hz
VAMPL = 220V
VOFF = 0

D1

D1N4009

RL

1000

5

Rs

10

1 3
D2

D1N4009

4

L2

10uH

    FULL WAVE RECTIFIER 
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RESULT:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
CONCLUSION: Thus we have studied the full wave rectifier using TINAPRO window and 
observed its output on the virtual CRO. 
 

 

 

 

 

 

 

 

 

     FULL WAVE RECTIFIER 
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QUIZ QUESTIONS & ANSWERS 

 

Q. No. QUESTION  ANSWER 

 

1 Define Full wave rectifier? In both the half cycles current flows through the load 
in the same direction. 

2 Which are different types of Full 
Wave rectifier? 

Different types of full wave rectifier are Centre-Tap 
full wave rectifier & Bridge rectifier 

3 How many no. of diodes are used in 
full wave rectifier? 

 4 No. of diodes are used for Bridge rectifier. 

4 Give disadvantage of centre-Tap full 
wave rectifier? 

 Necessity of transformer with secondary winding. 

5 Write ripple factor for FW rectifier?  The ripple factor for Full wave rectifier is 0.48. 

6 What is the efficiency of FW 
rectifier? 

 Efficiency of full wave rectifier is 81.2%. 

7  Write advantages of bridge rectifier? Suitable for high-voltage applications. 

 

8 Write one feature of Full wave 
rectifier? 

 

 The current drawn in both the primary & secondary of 
the supply transformer is Sinusoidal. 

 

9  Define Transformer Utilization 
Factor? 

 Transformer Utilization Factor (TUF) is the ratio of 
d.c power to be delivered to the load to the a.c  rating 
of the  Transformer secondary. 

10  What is DC current?  DC current is Idc= Im / П. 
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EXPERIMENT NO:5 
AIM:  Design a clipper circuits using TINAPRO. 

APPARATUS: PC installed with TINAPRO 

CIRCUIT DIAGRAM:  
 

 
 
 
 
 
 
 

CLIPPER CIRCUITS 

VDC
1Vdc

VAC

FREQ = 30kHz
VAMPL = 5V
VOFF = 0

3

VAC

FREQ = 30kHz
VAMPL = 5V
VOFF = 0

1

VDC1
1.5Vdc

2

D1
D1N3940

2

2

3

D1
D1N3940

D1
D1N3940

D1
D1N3940

D1
D1N3940

R

.22K

1

VAC

FREQ = 30kHz
VAMPL = 5V
VOFF = 0

3

VDC
1Vdc

R

.22K
3

VDC2
1Vdc

D2
D1N3940

VDC
1Vdc

2

VAC

FREQ = 30kHz
VAMPL = 5V
VOFF = 0

2

D1
D1N3940

VAC

FREQ = 30kHz
VAMPL = 5V
VOFF = 0

R

.22K

1

D1
D1N3940

2

VDC
1Vdc

1

VAC

FREQ = 30kHz
VAMPL = 5V
VOFF = 0

R

.22K

1

2

R4

.22K

R

.22K

1

1

R

.22K

VAC

FREQ = 30kHz
VAMPL = 5V
VOFF = 0

Figure 1 

Figure 7 

Figure 6 

Figure 5 

Figure 4 

Figure 2 

Figure 3 
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PROGRAM:  
 
Prog. 1 
*******CLIPPER 1 
R 1 2 .22K 
D1 2 0 D1N3940 
VAC 1 0 SIN(0 5V 30KHZ) 
.MODEL D1N3940 D( 
+         IS = 4E-10 
+         RS = .105 
+          N = 1.48 
+         TT = 8E-7 
+        CJO = 1.95E-11 
+         VJ = .4 
+          M = .38 
+         EG = 1.36 
+        XTI = -8 
+         KF = 0 
+         AF = 1 
+         FC = .9 
+         BV = 600 
+        IBV = 1E-4 
+ ) 
.PROBE 
.TRAN 0US 100US 
.END 
 
Prog. 2 
*******CLIPPER 1 
R 1 2 .22K 
D1 2 3 D1N3940 
VAC 1 0 SIN(0 5V 30KHZ) 
VDC 3 0 DC 1V 
.MODEL D1N3940 D( 
+         IS = 4E-10 
+         RS = .105 
+          N = 1.48 
+         TT = 8E-7 
+        CJO = 1.95E-11 
+         VJ = .4 
+          M = .38 
+         EG = 1.36 
+        XTI = -8 
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+         KF = 0 
+         AF = 1 
+         FC = .9 
+         BV = 600 
+        IBV = 1E-4 
+ ) 
.PROBE 
.TRAN 0US 100US 
.END 
 
Prog. 3 
*******CLIPPER 3 
R 1 2 .22K 
D1 2 3 D1N3940 
VAC 1 0 SIN(0 5V 30KHZ) 
VDC 0 3 DC 1V 
.MODEL D1N3940 D( 
+         IS = 4E-10 
+         RS = .105 
+          N = 1.48 
+         TT = 8E-7 
+        CJO = 1.95E-11 
+         VJ = .4 
+          M = .38 
+         EG = 1.36 
+        XTI = -8 
+         KF = 0 
+         AF = 1 
+         FC = .9 
+         BV = 600 
+        IBV = 1E-4 
+ ) 
.PROBE 
.TRAN 0US 100US 
.END 
 
Prog. 4 
*******CLIPPER 4 
R 1 2 .22K 
D1 0 2 D1N3940 
VAC 1 0 SIN(0 5V 30KHZ) 
.MODEL D1N3940 D( 
+         IS = 4E-10 
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+         RS = .105 
+          N = 1.48 
+         TT = 8E-7 
+        CJO = 1.95E-11 
+         VJ = .4 
+          M = .38 
+         EG = 1.36 
+        XTI = -8 
+         KF = 0 
+         AF = 1 
+         FC = .9 
+         BV = 600 
+        IBV = 1E-4 
+ ) 
.PROBE 
.TRAN 0US 100US 
.END 
 
Prog. 5 
*******CLIPPER 5 
R 1 2 .22K 
D1 3 2 D1N3940 
VAC 1 0 SIN(0 5V 30KHZ) 
VDC 0 3 DC 1V 
.MODEL D1N3940 D( 
+         IS = 4E-10 
+         RS = .105 
+          N = 1.48 
+         TT = 8E-7 
+        CJO = 1.95E-11 
+         VJ = .4 
+          M = .38 
+         EG = 1.36 
+        XTI = -8 
+         KF = 0 
+         AF = 1 
+         FC = .9 
+         BV = 600 
+        IBV = 1E-4 
+ ) 
.PROBE 
.TRAN 0US 100US 
.END 
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Prog. 6 
*******CLIPPER 6 
R 1 2 .22K 
D1 3 2 D1N3940 
VAC 1 0 SIN(0 5V 30KHZ) 
VDC 3 0 DC 1V 
.MODEL D1N3940 D( 
+         IS = 4E-10 
+         RS = .105 
+          N = 1.48 
+         TT = 8E-7 
+        CJO = 1.95E-11 
+         VJ = .4 
+          M = .38 
+         EG = 1.36 
+        XTI = -8 
+         KF = 0 
+         AF = 1 
+         FC = .9 
+         BV = 600 
+        IBV = 1E-4 
+ ) 
.PROBE 
.TRAN 0US 100US 
.END 
 
Prog. 7 
*******CLIPPER 7 
R 1 2 .22K 
D1 3 2 D1N3940 
D2 2 4 D1N3940 
VAC 1 0 SIN(0 5V 30KHZ) 
V1_VDC1 4 0 DC 1V 
V2_VDC2 0 3 DC 1.5V 
.MODEL D1N3940 D( 
+         IS = 4E-10 
+         RS = .105 
+          N = 1.48 
+         TT = 8E-7 
+        CJO = 1.95E-11 
+         VJ = .4 
+          M = .38 
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+         EG = 1.36 
+        XTI = -8 
+         KF = 0 
+         AF = 1 
+         FC = .9 
+         BV = 600 
+        IBV = 1E-4 
+ ) 
.PROBE 
.TRAN 0US 100US 
.END 
 
RESULT:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Result of CLIPPER 1

Result of CLIPPER 2
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Result of CLIPPER 3 

Result of CLIPPER 4 
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Result of CLIPPER 5 

Result of CLIPPER 6 
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CONCLUSION: Thus we have studied the full wave rectifier using TINAPRO window and 
observed its output on the virtual CRO. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Result of CLIPPER 7 
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QUIZ QUESTIONS & ANSWERS 

Q. No QUESTION ANSWER 

1. What is non-linear wave shaping? Non linear wave shaping is the process, on 
applying any wave at input of a non-linear device 
the shape of the output wave varies non-linearly 
with the input wave. 

2. Which are the circuits for non-
linear wave shaping? 

Clipping circuit & Clamping circuits are the 
circuits for non-linear wave shaping. 

3. What is  clipping circuit ? A wave-shaping circuit which controls the output 
waveform by removing or clipping a portion of the 
applied wave is known as clipping circuit. 

4. According to non-linear devices 
how clippers can be classified. 

According to non-linear devices clippers can be 
classified as diodes clippers & transistor clippers. 

5. According to configuration used 
classify clippers. 

According to configuration used classify clippers 
can be classified asa)Series diode clipper. b) 
Parallel or shunt diode clipper. c) Combination 
clippers.  

6. Classify clippers according to 
level of clippers. 

According to level of clipping the clippers may be  
a) Positive clippers. b)Negative clippersc) Biased 
clippers d) Combinational clippers. 

7. What is positive clipper circuit? Positive clipper is one which removes the positive 
half cycles of the input voltage 

8. What is negative clipper circuit? Negative clipper is one which removes the negative 
half cycles of the input voltage 

9. What is clamping? A circuit that places either the positive or negative 
peak of a signal at a desired level is known as 
Clamping circuit. 

10. How many types of clampers are 
there? 

There are 2 types of clampers 

a) Positive clamper. b)Negative clamper 
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EXPERIMENT NO:6 
AIM:  Design a clamper circuits using TINAPRO. 

APPARATUS: PC installed with TINAPRO 

CIRCUIT DIAGRAM:  
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PROGRAM:  
 
Prog. 1 
****CLAMPER1 
C_C1 1 2 .01uf 
R_R1 2 0 560k 
D_D1 2 0 D1N3491 
V_VAC 1 0 sin(0 5v 30khz) 
.model D1N3491 D(Is=68.65f Rs=3.786m Ikf=1.774 N=1 Xti=2 Eg=1.11 Cjo=1.457n 
+  M=.9735 Vj=.75 Fc=.5 Isr=11.02u Nr=2 Tt=6.059u) 
*  Motorola pid=1N3491 case=DO21 
*  88-08-24 rmn 
.probe 
.tran 0us 100us 
.end 
 
Prog. 2 
****CLAMPER2 
C_C1 1 2 .01uf 
R_R1 2 0 560k 
D_D1 2 3 D1N3491 
V_VDC 3 0 1V 
V_VAC 1 0 sin(0 5v 30khz) 
.model D1N3491 D(Is=68.65f Rs=3.786m Ikf=1.774 N=1 Xti=2 Eg=1.11 Cjo=1.457n 
+  M=.9735 Vj=.75 Fc=.5 Isr=11.02u Nr=2 Tt=6.059u) 
*  Motorola pid=1N3491 case=DO21 
*  88-08-24 rmn 
.probe 
.tran 0us 100us 
.end 
 
Prog. 3 
****CLAMPER3 
C_C1 1 2 .01uf 
R_R1 2 0 560k 
D_D1 2 3 D1N3491 
V_VDC 0 3 1V 
V_VAC 1 0 sin(0 5v 30khz) 
.model D1N3491 D(Is=68.65f Rs=3.786m Ikf=1.774 N=1 Xti=2 Eg=1.11 Cjo=1.457n 
+  M=.9735 Vj=.75 Fc=.5 Isr=11.02u Nr=2 Tt=6.059u) 
*  Motorola pid=1N3491 case=DO21 
*  88-08-24 rmn 
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.probe 

.tran 0us 100us 

.end 
 
Prog. 4 
****CLAMPER4 
C_C1 1 2 .01uf 
R_R1 2 0 560k 
D_D1 0 2 D1N3491 
V_VAC 1 0 sin(0 5v 30khz) 
.model D1N3491 D(Is=68.65f Rs=3.786m Ikf=1.774 N=1 Xti=2 Eg=1.11 Cjo=1.457n 
+  M=.9735 Vj=.75 Fc=.5 Isr=11.02u Nr=2 Tt=6.059u) 
*  Motorola pid=1N3491 case=DO21 
*  88-08-24 rmn 
.probe 
.tran 0us 100us 
.end 
 
Prog. 5 
****CLAMPER5 
C_C1 1 2 .01uf 
R_R1 2 0 560k 
D_D1 3 2 D1N3491 
V_VDC 3 0 1V 
V_VAC 1 0 sin(0 5v 30khz) 
.model D1N3491 D(Is=68.65f Rs=3.786m Ikf=1.774 N=1 Xti=2 Eg=1.11 Cjo=1.457n 
+  M=.9735 Vj=.75 Fc=.5 Isr=11.02u Nr=2 Tt=6.059u) 
*  Motorola pid=1N3491 case=DO21 
*  88-08-24 rmn 
.probe 
.tran 0us 100us 
.end 
 
Prog. 6 
****CLAMPER6 
C_C1 1 2 .01uf 
R_R1 2 0 560k 
D_D1 3 2 D1N3491 
V_VDC 0 3 1V 
V_VAC 1 0 sin(0 5v 30khz) 
.model D1N3491 D(Is=68.65f Rs=3.786m Ikf=1.774 N=1 Xti=2 Eg=1.11 Cjo=1.457n 
+  M=.9735 Vj=.75 Fc=.5 Isr=11.02u Nr=2 Tt=6.059u) 
*  Motorola pid=1N3491 case=DO21 
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*  88-08-24 rmn 
.probe 
.tran 0us 100us 
.end 
 
RESULT:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Result of CLAMPER1

Result of CLAMPER2 
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Result of CLAMPER3 

Result of CLAMPER4 
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CONCLUSION: Thus we have studied the clamper circuits using TINAPRO window and 
observed its output on the virtual CRO. 
 
 
 
 

Result of CLAMPER5

Result of CLAMPER6 
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QUIZ QUESTIONS & ANSWERS 

Q. No QUESTION ANSWER 

1. What is non-linear wave shaping? Non linear wave shaping is the process, on 
applying any wave at input of a non-linear device 
the shape of the output wave varies non-linearly 
with the input wave. 

2. Which are the circuits for non-
linear wave shaping? 

Clipping circuit & Clamping circuits are the 
circuits for non-linear wave shaping. 

3. What is  clipping circuit ? A wave-shaping circuit which controls the output 
waveform by removing or clipping a portion of the 
applied wave is known as clipping circuit. 

4. According to non-linear devices 
how clippers can be classified. 

According to non-linear devices clippers can be 
classified as diodes clippers & transistor clippers. 

5. According to configuration used 
classify clippers. 

According to configuration used classify clippers 
can be classified asa)Series diode clipper. b) 
Parallel or shunt diode clipper. c) Combination 
clippers.  

6. Classify clippers according to 
level of clippers. 

According to level of clipping the clippers may be  
a) Positive clippers. b)Negative clippersc) Biased 
clippers d) Combinational clippers. 

7. What is positive clipper circuit? Positive clipper is one which removes the positive 
half cycles of the input voltage 

8. What is negative clipper circuit? Negative clipper is one which removes the negative 
half cycles of the input voltage 

9. What is clamping? A circuit that places either the positive or negative 
peak of a signal at a desired level is known as 
Clamping circuit. 

10. How many types of clampers are 
there? 

There are 2 types of clampers 

a) Positive clamper. b)Negative clamper 
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EXPERIMENT NO:7 
AIM:  Design a RLC resonance circuit & verify the transient response for different values of   R, 
L &C 

APPARATUS: PC installed with TINAPRO 

CIRCUIT DIAGRAM:  
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
PROGRAM:  
 
****Exp Transient Response of an RLC-circuit with a sinusoidal input voltage 

*  SIN  (VO    VA    FREQ)         ;  Simple sinusoidal source  
VIN  1   0   SIN (0   10V   5KHZ)  ; sinusoidal input voltage 
R1   1   2   2  
L1   2   3   50UH  
C1   3   0   10UF 
.TRAN   1US    500US               ; Transient analysis 
.PLOT  TRAN  V(3)  V(1)            ; Plots on the output file  
.PROBE                             ; Graphical waveform analyzer 
.END                               ; End of circuit file 
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RESULT:  
 
 
 

 
 
 
 
CONCLUSION: Thus we have studied transient response of RLC circuit for different values of   
R, L &C 
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QUIZ QUESTIONS & ANSWERS 

Q1What is RLC circuit? 

Ans. An RLC circuit (or LCR circuit) is an electrical circuit consisting of a resistor, an inductor, 
and a capacitor, connected in series or in parallel. 

Q2 Why it is called RLC? 

Ans. The RLC part of the name is due to those letters being the usual electrical symbols 
for resistance, inductance and capacitance respectively. 

Q.3 Name application of RLC. 

 Ans. There are many applications for this circuit. They are used in many different types 
of oscillator circuit. Another important application is for tuning, such as in radio 
receivers or television sets. 

Q4.What is relation between angular frequency and resonance frequency? 

Ans. An important property of this circuit is its ability to resonate at a specific frequency, 
the resonance frequency, . Frequencies are measured in units of hertz. In this article, 
however, angular frequency, , is used which is more mathematically convenient. This is 
measured in radians per second. They are related to each other by a simple proportion, 

 
 

Q5What is resonance frequency? 

Ans. The resonance frequency is defined as the frequency at which the impedance of the circuit 
is at a minimum. 

Q6 What is Damping? 

Ans. Damping is caused by the resistance in the circuit. It determines whether or not the circuit 
will resonate naturally (that is, without a driving source). 

Q7 What is Q factor? 

Ans. The Q factor is a widespread measure used to characterise resonators. It is defined as the 
peak energy stored in the circuit divided by the average energy dissipated in it per cycle at 
resonance. 
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Q8 What do you mean by transient response? 

Ans. Transient response or natural response is the response of a system to a change from 
equilibrium. The transient response is not necessarily tied to "on/off" events but to any event that 
affects the equilibrium of the system. 

Q.9 What is Rise time? 
Ans. Rise time refers to the time required for a signal to change from a specified low value to a 
specified high value. Typically, these values are 10% and 90% of the step height. 
Q. 10 What is Overshoot? 
Ans. Overshoot is when a signal or function exceeds its target. It is often associated with ringing. 
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EXPERIMENT NO:8 
AIM:  Convert the power supply circuit into PCB & simulates its 2D & 3D view. 

APPARATUS: PC installed with TINAPRO. 

THEORY:  
 
Creating a PCB for the circuit simulated in the software involves certain basic steps. 
 
 Setting and checking footprint names:  
 
To achieve an accurate PCB design, one that is easy to build, every part in your schematic must 
have a physical representation with exact physical size.  This is realized through so-called 
footprints: drawings showing the outline and the pins of the parts. Default footprint names to all 
parts are already defined that represent real components. Some parts used for theoretical 
investigations, controlled sources, for example, do not represent real physical parts and cannot be 
placed on a PCB. If your design contains such components, you should replace them with real 
physical parts. 
Of course there is no guarantee that the default physical packages parts are the same as needed 
by your design. 
 
There are two ways to check this. 
 
1) You  can  use  “Footprint  name  editor”,  which  you  can  invoke  from  Tools  menu.  In this 
dialog you can see all of components and their corresponding footprint names. 
 
2) The second way to examine the assigned footprints is to double-click on each part and check 
the Footprint Name in the component property dialog that appears. 
 
2D/3D view checking: 
 
After completing the checking of the footprint names check the 2D/3D shape by clicking the 
2D/3D view button or the F6 key. Unless a component is only meaningful for analysis, it will 
have a 3D view. If the physical part association is OK, we can begin the PCB layout design. 
 
PCB Designing :  
To begin PCB design, select the “PCB Design” command on the Tools menu. Set the parameters 
as required. Select “Start New Project,”  “Auto placement”and“Use board template.”  With the 
Browse button find and select the 2layer_A.tpt template file from Template folder. When starting 
with a template, you are choosing the level of manufacturing complexity of your project. The 
following three levels of manufacturing technology are defined by the IPC-2221 generic 
standard: 
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Level A : General Design Complexity 
Level B : Moderate Design Complexity 
Level C : High Design Complexity 
 
The template file specifies the number of layers, including their properties, system grid size, auto 
router settings, spacing and track width. 
 
In choosing a PCB template, you should take into consideration technology, density, and 
package pitch.To complete the set up, set  the  PCB size in inches or mm depending  on  the 
measurement unit settings in the View/Options dialog .Now that everything is set properly press 
the OK button and the PCB layout design will appear with all the components automatically 
placed on the PCB board. While all the parts and nets are placed, we need to adjust their 
positions for good placement and easier routing. 
 
Press F4 to reach the Net Editor and set net routing width. First, click on “Modify all” 
and enter 12.5 into “Track width” field. Then select power nets (Ground, VCC, -VCC) 
and set their width to 25mil. To  automatically  route  the  PCB, press  the  F5  button  or  select  
“Autoroute board”command from the Tools menu. 
 
Finally, check your design in full 3D. Press F3 or select 3D View from the View menu. After 
some calculation, 3D view appears on the screen. 
 
Lastly take the print out of the PCB generated on the trace paper to develop the PCB in hardware 
lab.  
 
 
 
CONCLUSION: Thus we have obtained the print of the power supply PCB to develop the PCB 
in hardware lab.  
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QUIZ QUESTIONS & ANSWERS 

Q.1 What do you mean by2D/3D view checking? 

Ans. 2D/3D view checking: After completing the checking of the footprint names check the 
2D/3D shape by clicking the 2D/3D view button or the F6 key. Unless a component is only 
meaningful for analysis, it will have a 3D view. If the physical part association is OK, we can 
begin the PCB layout design. 
 

Q.2 What’s role Tina play in Integrated PCB design? 

Ans. The new fully integrated layout module of TINA has all the features you need for advanced 
PCB design, including multilayer PCB's with split power plane layers, powerful auto placement 
& auto routing, rip-up and reroute, manual and "follow-me" trace placement, DRC, forward and 
back annotation, pin and gate swapping, keep-in and keep-out areas, copper pour, thermal relief, 
fan out, 3D view of your PCB design from any angle, Gerber file output and much more. 

Q.3 What is PCB printing using screen printing? 

Ans. Screen printing techniques actually the process that patterns the metal conductor to form the 
circuit.  

Q.4 What do you  mean by PCB fabrication process? 

Ans. This PCB fabrication process involves a multistep integration of imaging materials, 
imaging equipment, and processing conditions with the metallization process to reduce the 
master pattern on a substrate.  

Q5 What is Patterning (etching)? 

Ans.The vast majority of printed circuit boards are made by bonding a layer of copper over the 
entire substrate, sometimes on both sides, (creating a "blank PCB") then removing unwanted 
copper after applying a temporary mask (e.g., by etching), leaving only the desired copper traces. 

Q.6 What is Silk screen? 

Ans. Silk screen printing uses etch-resistant inks to protect the copper foil. Subsequent etching 
removes the unwanted copper. Alternatively, the ink may be conductive, printed on a blank (non-
conductive) board. The latter technique is also used in the manufacture of hybrid circuits. 
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Q.7What is Photoengraving? 

Ans. Photoengraving uses a photo mask and developer to selectively remove 
a photoresist coating. The remaining photoresist protects the copper foil. Subsequent etching 
removes the unwanted copper. The photomask is usually prepared with aphotoplotter from data 
produced by a technician using CAM, or computer-aided manufacturing software. Laser-printed 
transparencies are typically employed for phototools; however, direct laser imaging techniques 
are being employed to replace phototools for high-resolution requirements. 

Q.8 What is PCB milling? 

Ans. PCB milling uses a two or three-axis mechanical milling system to mill away the copper 
foil from the substrate. A PCB milling machine (referred to as a 'PCB Prototyper') operates in a 
similar way to a plotter, receiving commands from the host software that control the position of 
the milling head in the x, y, and (if relevant) z axis. 
 

Q.9 What material is used for Chemical etching? 

Ans. Chemical etching is done with ferric chloride, ammonium persulfate, or sometimes 
hydrochloric acid. 

Q.10 What is lamination? 

Ans. Lamination: Some PCBs have trace layers inside the PCB and are called multi-layer PCBs. 
These are formed by bonding together separately etched thin boards. 
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EXPERIMENT NO:9 
AIM:  Introduction of the materials required for the fabrication of PCB’s 

THEORY:  
 
The designer as well as manufactures prefers to use both the imperial as well as no imperial 
system of units.The most important to remember is:  
1mil = inch by 1000  
1mil= 25.4 micron 
1micron= 1mm by 1000Tracks on a PCB add inductance, resistance and capacitance to the 
circuit.  
 
INDUCTANCE: 
The amount of inductance is relatively constant across substrate types and depends on the length 
of track. The inductance per unit length of copper track is similar to that for a component lead.  
 
RESISTANCE: 
Resistance of the track depends on the cross-sectional area of the track as well as the length, 
hence values are usually quoted in resistance per square for each weight of copper the most 
popular copper weight,1 oz., gives a typical value of 0.49mΩ/square. 
 
CAPACITANCE: 

 
A=coverage area  
H=distance between tracks  
Therefore a 1 oz. copper track, .5mm (0.020 “) wide, 20 mm (.8“) long over a ground plane on a 
.25 mm (.010”) thick FR4 laminate would exhibit a resistance of 9.8mΩ, an inductance of 
20nH,and a capacitive coupling to ground of 1.66 pF. These values may seem like low and 
negligible but when we talk of so many track then these values add up. These parasitic effects are 
under designers control very much like components values. There are other design constraints 
like production, marketing cost etc. Some important tables are given here for the ready reference 
and handy, fast calculations.  
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CONCLUSION: 
 
The availability of the copper plate of the proper size is the first and foremost requirement for the 
making of the PCB.In addition to it, you also require the precision high speed cutter blade for the 
fine and précised cutting of these copper plates to the required size. There can be the manual 
drilling machine for the drilling of the holes for components to be placed or the automatic plant 
as to the availability of the resources at your hand. There is the list of other equipment to add this 
like a personal computer printer, saw, scale, photo plotter, screen printing facility, chemicals, 
chemical treatment plant for the exposing and lamination of the PCB.  
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QUIZ QUESTIONS & ANSWERS 

Q.1 What’s role Tina play in Integrated PCB design? 

Ans. The new fully integrated layout module of TINA has all the features you need for advanced 
PCB design, including multilayer PCB's with split power plane layers, powerful autoplacement 
& autorouting, rip-up and reroute, manual and "follow-me" trace placement, DRC, forward and 
back annotation, pin and gate swapping, keep-in and keep-out areas, copper pour, thermal relief, 
fanout, 3D view of your PCB design from any angle, Gerber file output and much more. 

Q.2 What is PCB printing using screen printing? 

Ans. Screen printing techniques actually the process that patterns the metal conductor to form the 
circuit.  

Q.3What do you  mean by PCB fabrication process? 

Ans. This PCB fabrication process involves a multistep integration of imaging materials, 
imaging equipment, and processing conditions with the metallization process to reduce the 
master pattern on a substrate.  

Q.4 What is Solder resist? 

Ans. Areas that should not be soldered may be covered with a polymer solder resist. 

 

Q.5 What is Copper thickness? 

Ans.Copper thickness of PCBs can be specified in units of length, but is often specified as 
weight of copper per square foot, in ounces, which is easier to measure. Each ounce of copper is 
approximately 1.4 mils (0.0014 inch) or 35 μm of thickness. 

Q.6 What material used for PCB fabrication process? 

Ans.These new materials include eco-friendly FR polymers, ultra-fine PCB substrate yarns, 
thermally enhanced substrates, halogen-free LCPs, as well as flex circuit materials. 

Q.7What is Silver Conductive Inks? 

Ans.These silver conductive inks are formulated for use in printed electronics, to meet the need 
for low-cost processing in touchscreens and OLEDs.  
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Q8 What is Patterning (etching)? 

Ans.The vast majority of printed circuit boards are made by bonding a layer of copper over the 
entire substrate, sometimes on both sides, (creating a "blank PCB") then removing unwanted 
copper after applying a temporary mask (e.g., by etching), leaving only the desired copper traces. 

Q.9 What is Silk screen? 

Ans. Silk screen printing uses etch-resistant inks to protect the copper foil. Subsequent etching 
removes the unwanted copper. Alternatively, the ink may be conductive, printed on a blank (non-
conductive) board. The latter technique is also used in the manufacture of hybrid circuits. 

 
Q.10 What material is used for Chemical etching? 

Ans. Chemical etching is done with ferric chloride, ammonium persulfate, or sometimes 
hydrochloric acid. 
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EXPERIMENT NO:10 
AIM:  Development of PCB in hardware lab. 

APPARATUS:  

1) PCB art work film maker NV180 
2) Artwork table NV181 
3) PCB shearing machine NV182 
4) Photo resist dip coating machine NV183 
5) UV exposure unit NV184 
6) Dye tank NV185 
7) Development tank NV186 
8) PCB etching machine NV187 
9) Drill machine NV188 

 
ACCESORIES: 
 

1) Tray 
2) Brush 
3) PCB Laminate 
4) Spray 
5) Hand gloves 

 
THEORY:  
 
The development of the PCB involves following steps. 
 

1) PCB printing using screen printing 
2) Etching of the PCB 
3) Drilling of PCB. 
4) Coating of etched PCB to protect it from oxidation. 

 

PCB printing using screen printing:  
 
 Screen printing techniques actually the process that patterns the metal conductor to form the 
circuit. This PCB fabrication process involves a multistep integration of imaging materials, 
imaging equipment, and processing conditions with the metallization process to reduce the 
master pattern on a substrate. Screen printing is considered as the most versatile of all printing 
processes as it can be done on wide variety of substrates of any shape, thickness and size. The 
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screen printing process is simple, and a wide variety of inks and dyes are available for use in 
screen printing than for use in any other printing process.  

Etching of the PCB: 

The final copper pattern is formed by selective removal of the unwanted copper which is not 
protected by an electric resist. FeCl3 solution is popularly used etching solution. FeCl3 powder 
will remove the copper from the unprotected part of the PCB. After removing the PCB it is dried 
for some time. 

Drilling of PCB:  

After etching of the PCB the next step is to drill the PCB for the interconnection of the various 
components on the PCB. The drill hole is having a diameter of generally one mm but the 
resistance sometimes require 1.5mm diameter. The drilling of the PCB is very important in terms 
of the working of the PCB hence the drilling is done by drilling machine of large precision and 
accuracy. 

Coating of etched PCB to protect it from oxidation:  

Since the upper layer of the PCB is a copper clad material which gets oxidised when comes in 
contact with the environment that affects the performance of the PCB. Hence the copper layer is 
coated with the laminates that are basically an insulator, to protect the Etched PCB to get 
oxidized. 

 

PROCEDURE:  
 
1. Take 50 ml water in a beaker and add 3 gm of sensitizer powder to it. 

2. Add 50 ml water to sensitizer solution to make 100 ml solution. 

3. Take 10 ml screen coating solution and add 10 drops of sensitizer solution to it. 

3. Cut the Light Sensitive film as per the size of PCB layout. Arrange the film and on PCB 
screen Printing Unit. 

4. Coat the Light Sensitive film on the screen with the Squeeze and dry the screen in the curing 
machine for 5 minutes. Remove the plastic paper from film and dry it again for 5 minutes. 

5.Take the print of PCB layout on the plotting paper and place it on UV exposure such that 
solder side is in contact with glass. 
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6. Place screen then Rubber sheet and then weight. 

7. Develop the screen by spraying water from 1 feet and dry the screen for 15 minutes in the 
open air. 

8. Mount the Screen with the help of clamp on PCB Screen Printing Unit and cut it with the help 
of shearing machine 

9. PlacePCB Laminate to print and pour the ink inside the screen. 

10. Pour 7 ltr water in the tank and add 2kg Ferric Chloride and stir it. 

11. Mount the PCB on the clamp of Dipping Arrangement and dip the PCB on clamp from the 
opening of cover plate. 

12. Drill the PCB with appropriate size of drill bit. 

 

CONCLUSION:  Thus we have developed the PCB in the hardware Lab. 
 

QUIZ QUESTIONS & ANSWERS 

Q.1 What’s role Tina play in Integrated PCB design? 

Ans. The new fully integrated layout module of TINA has all the features you need for advanced 
PCB design, including multilayer PCB's with split power plane layers, powerful autoplacement 
& autorouting, rip-up and reroute, manual and "follow-me" trace placement, DRC, forward and 
back annotation, pin and gate swapping, keep-in and keep-out areas, copper pour, thermal relief, 
fanout, 3D view of your PCB design from any angle, Gerber file output and much more. 

Q.2 What is PCB printing using screen printing? 

Ans. Screen printing techniques actually the process that patterns the metal conductor to form the 
circuit.  

Q.3What do you  mean by PCB fabrication process? 

Ans. This PCB fabrication process involves a multistep integration of imaging materials, 
imaging equipment, and processing conditions with the metallization process to reduce the 
master pattern on a substrate.  

Q.4 Which Screen printing  is most versatile? 
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Ans.Screen printing is considered as the most versatile of all printing processes as it can be done 
on wide variety of substrates of any shape, thickness and size. The screen printing process is 
simple, and a wide variety of inks and dyes are available for use in screen printing than for use in 
any other printing process.  

Q.5 What do you mean by Etching of the PCB? 

Ans.The final copper pattern is formed by selective removal of the unwanted copper which is not 
protected by an electric resist. FeCl3 solution is popularly used etching solution. FeCl3 powder 
will remove the copper from the unprotected part of the PCB. After removing the PCB it is dried 
for some time. 

Q.6 What do you mean by Drilling of PCB?  

Ans.After etching of the PCB the next step is to drill the PCB for the interconnection of the 
various components on the PCB. The drill hole is having a diameter of generally one mm but the 
resistance sometimes require 1.5mm diameter. The drilling of the PCB is very important in terms 
of the working of the PCB hence the drilling is done by drilling machine of large precision and 
accuracy. 

Q. 7  What is TINA Design Suite? 

Ans. TINA Design Suite is a powerful yet affordable circuit simulation and PCB design software 
package. 

Q.8 Why TINA Design Suite  is used? 

Ans. It is used for analyzing, designing, and real time testing of analog, digital, VHDL, MCU, 
and mixed electronic circuits and their PCB layouts. 

Q.9 What is unique feature of TINA? 

Ans. A unique feature of TINA is that you can bring your circuit to life with the optional USB 
controlled. 

Q.10  How it is used to compute computational power? 

Ans. To meet this requirement TINA v9 has the ability to utilize the increasingly popular 
scalable multi-thread CPUs. 

 

 


